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Teacher Resource 15.1
Presentation Notes: Overview of Types of Networks
Before you show this presentation, use the text accompanying each slide to develop presentation notes. Writing the notes yourself enables you to approach the subject matter in a way that is comfortable to you and engaging for your students. Make this presentation as interactive as possible by stopping frequently to ask questions and encourage class discussion.  
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This presentation provides an overview of the different types of networks, including LANs and WANs. It also discusses the types of network connections and the two basic types of network architectures. 

	Presentation notes
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A computer network is a group of two or more computers linked together to share files, printers, and resources. A network can be as simple as two interconnected PCs sharing files, a printer, and a modem or as complex as the Internet, which is made up of millions of interconnected networks sharing resources worldwide. 
A client is a device on a network that makes requests of the network’s server(s). Typically, a client is a PC or laptop computer linked to a network through a network interface card (NIC) and a cable or through a wireless connection. Clients are usually intended to be used by one person at a time.
Clients share data and applications that are stored on a server, which is a powerful computer running a high-speed processor. 
For maximum performance on a large network, a server needs a network operating system, high-speed NICs, and access to a large amount of permanent storage, either in the form of several large hard drives or a storage area network (SAN). A server also needs enough RAM to support the applications that the server runs to manage the requests of a large network. 

	Presentation notes
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These are the two most common types of networks: 
· Local area network (LAN): A group of networked computers, usually located within one building or adjacent buildings such as a home, an office, or a school. LANs are limited to distances of up to one mile and are connected via dedicated cables. Devices on a LAN are typically connected together by some form of cable or short-distance wireless communication. LANs, if they are connected to a WAN, are typically connected by one of several different forms of telecommunications, whether cell tower, telephone lines, coaxial cable to a cable company, or fiber-optic cable. In some cases, people download over a satellite dish and upload by telephone line.
· Wide area network (WAN): Groups of LANs connected over a wide geographical area. A WAN can span a city, state, country, or the world. Leased satellite hookups, telephone lines, TV cables, or fiber-optic backbones link WANs together. The largest and best-known example of a WAN is the Internet.

	Presentation notes
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A SAN is a highly specialized type of LAN that is designed to make large amounts of storage available to the other servers on the network. In this way, not only do the clients of the network have access to file storage, but the SAN itself can balance the load (the requests) so that clients are not left waiting. Otherwise, a file server may be busy enough that clients are left waiting for their requests to be filled.
Instead of needing to add and upgrade hard drives on a server (which would require that server to be taken offline), administrators can easily add drives to the SAN, leaving the servers up and operational the entire time.

	Presentation notes
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A network backbone is the infrastructure that connects the pieces of the network together. This connection provides a data path between different LANs. 
On a WAN, a backbone is a set of paths that local or regional networks connect to for long-distance interconnection. For example, a large corporation with many office locations will have a backbone network that ties all of the locations together. A backbone uses a larger transmission line that carries data from the smaller lines that connect with it. 
The Internet’s backbone has changed over time but has always had the greatest bandwidth of all of the connections on the Internet. Original backbone sites were managed by the US government and were located at various research facilities that had supercomputers. In the 1990s, the Internet became privatized, and control was given to telecommunication companies. Today, the Internet backbone is made up of resources developed and managed by these companies, including AT&T, Verizon, Sprint, and Comcast.

	Presentation notes
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Network connections can be either wired or wireless. 
· Ethernet networks use physical wiring to connect devices. Most networks use fiber-optic cable to tie key elements of the backbone together, while the clients are connected to the servers with CAT5e or CAT6 cable. CAT5 was the first type of cable that was widely used in Ethernet networks.  CAT5e cable is an enhanced version of CAT5. CAT6 is a newer standard that allows gigabit data speeds. Switches, bridges, and routers are all part of an Ethernet network’s backbone.
· Wireless LAN technology is designed to connect devices using a radio frequency rather than cabling. The device (laptop, mobile device) contains a wireless modem, which broadcasts a signal to a router that itself can receive wireless messages. Additionally, hot spots can be added to allow a greater distance between the device and the router. The hot spots are then usually connected to the router by cable. A wireless connection lets you move around within a broad coverage area and still be connected to the network. For the home user, wireless has become popular because of the ease of installation and, with the rising popularity of laptops and tablets, location freedom. Public spots such as coffee shops, malls, airports, and libraries offer their customers wireless access, often as a free service. Large wireless network projects are being put up in many major cities. 

	Presentation notes
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In a client/server network, the server can be dedicated to one task, such as managing network traffic, storing files and data, controlling access to email, or sharing a resource like a printer. A web server is a server dedicated to accepting requests from browsers and providing web pages such as HTML documents and linked images and other files. 
There are also nondedicated servers that perform a variety of tasks. In some environments, multiple servers are needed to handle all these tasks.
Clients are always dependent on the server when they need to access shared resources. Servers often back up client data on a regular schedule. 

	Presentation notes
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In a peer-to-peer network architecture, there is no server, and no individual computer is necessarily more powerful than another. Clients connect directly to each other in some manner, whether fully connected or partially connected. In some peer-to-peer networks, computers connect to a broadcast device. The peer-to-peer network allows computers to share data, devices, and resources with each other without the server. 
A peer-to-peer network is a decentralized network in which every computer (peer) shares the workload or can be called upon to share data or other resources. Peer-to-peer networks are typically found in home and small-office environments. They work best when fewer than a dozen computers are connected to the network. They generally are less expensive and easier to use than client/server networks. 
Although the Internet is not a peer-to-peer network, there are some applications carried over the Internet that use a peer-to-peer approach, where computers communicate directly with each other once a connection has been established, such as BitTorrent and Zoom. 

	Presentation notes
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The term intranet can also refer to a company’s internal website. An intranet website uses web servers and clients, but it uses a firewall to prevent unauthorized access. An intranet can also be used for teleconferencing. 

	Presentation notes
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A proxy server receives a request from a client and forwards it to other servers on behalf of the client. By acting as a buffer between a client and the Internet, the proxy server ensures security and administrative control. 
Sometimes the proxy server changes the client’s request or the server’s response, and sometimes it services the request without contacting the specified server. If an Internet site is requested often, the proxy server places the request in cache to save the information for later. Then if the proxy server receives a request for the same web page, it finds the page and returns it to the user without needing to forward the request to the Internet. This improves user response time by serving all users as quickly as possible. 
In addition, anonymous proxy servers hide your IP address to prevent unauthorized access to your computer over the Internet. This protects your computer from being directly targeted by any number of Internet-based attacks.
The proxy server’s actions are transparent to the user. All Internet requests and returned responses seem to be handled by the addressed Internet server. However, you must configure the IP address of the proxy server as an option in the Internet browser or other protocol program.

	Presentation notes
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A network can be as simple as two interconnected PCs sharing one printer or modem (called a peer-to-peer network) or as complex as the Internet (called a WAN). Networks are also important sources of information and support. Because networks are a large and growing part of computer systems, a solid foundation in networking is essential to a career in the IT industry.

	Presentation notes


Teacher Resource 15.2
Lecture/Demo Notes: 
Connecting a Windows System to a Network
Use these notes to guide students through the steps to set up a network connection. Use an LCD projector to demonstrate the steps when setting up a network in Windows 7, 8, or 10. Emphasize that there are two types of networks you can configure: a wired connection or a wireless connection. Be sure to explain the differences between the two.
Hardware Necessary to Connect a Network
You will need a network adapter for each computer you are connecting to the network. Some computers use a network interface card (NIC), which is usually an Ethernet expansion card that inserts directly into an expansion slot on the motherboard and connects a computer system to the network cabling through a port. Some newer computers have the network interface built into the motherboard, which is more cost-effective and sometimes offers better performance than a comparable adapter card.
You will also need a hub, switch, or router. If you want the computers on the network to share an Internet connection, you need to use a router.
To connect a computer to the network, use the Ethernet cables to plug the computer into the hub, switch, or router and then turn the computer on. Use Ethernet RJ-45 twisted-pair cabling, which is also called CAT5, CAT5E, CAT6, or CAT6e cabling. If your home is wired for Ethernet, you can connect your computers using Ethernet jacks in the wall. In a wired network, you will be connected immediately when you plug in the Ethernet cables. 
To confirm that the computer is on the network, do the following:
1.   Open the Network dialog box by clicking Control Panel. 
1. In the search box, type network. Under Network and Sharing Center, click “View network computers and devices.” 
2. You should see icons for all the computers and devices that are part of the network.
A wireless network uses a wireless network adapter and a wireless router to connect computers to each other or to a LAN. A wireless NIC connects to a radio-based computer network using an antenna to communicate through specially authorized radio frequencies. A wireless NIC in a desktop computer is connected using the PCI bus or a USB connection. Integrated wireless NICs are also available.
If your wireless router is compatible with your version of Windows (7, 8, or 10), you can use Windows Connect Now (WCN) to configure the wireless router automatically. You can tell if the router is compatible if it displays the Windows logo or if it says “Compatible with Windows 8” or something similar. If the router is not compatible with your version of Windows, it should have shipped with a setup CD that you can use. Follow the instructions in the setup CD to configure your router.
To connect to the Internet, you will need a cable modem or DSL modem and an account with an Internet service provider (ISP). 
Teacher Resource 15.3
Lecture/Demo Notes: Configuring a Browser
These notes are designed to help you demonstrate how to configure Internet Explorer 10 using an LCD projector connected to your computer. If your class uses another browser, you will need to adapt these notes.
Launch Internet Explorer
1. Click the Internet Explorer icon from the taskbar, the desktop, or the Start menu.
After the browser opens, give the students a guided tour around the screen, pointing out the following:
Menu Bar
Command Bar (just below the Menu Bar)
If your browser doesn’t automatically show these bars, right-click either end of the address bar and select Menu Bar and Command Bar to make them appear.
To add or remove a toolbar in Internet Explorer, follow these steps:
a. On the View menu, click Toolbars.
b. To add a toolbar, click to select the appropriate check box in the Toolbar area.
c. To remove a toolbar, click to clear the appropriate check box in the Toolbar area.
Demonstrate Security Options
By default, Internet Explorer categorizes websites in the Internet zone and assigns them a medium-high level of security. You can change the security level of the settings in this zone:
1. On the Tools menu, click Internet Options.
1. Click the Security tab and select the Internet icon.
1. Click the Custom level button. From the “Reset to:” drop-down menu, select the appropriate security level from the following list. Then click Reset and OK.
High: Appropriate for websites that might have harmful content; maximum safeguards; less-secure features are disabled
Medium-high: Appropriate for most websites; prompts before downloading potentially unsafe content; unsigned ActiveX controls will not be downloaded
Medium: Prompts before downloading potentially unsafe content; unsigned ActiveX controls will not be downloaded
You can assign websites to three other zones—Trusted Sites, Restricted Sites, and Local Intranet—based on your level of trust. To add sites to the Trusted Sites and Restricted Sites zones, click the icon for either Trusted Sites or Restricted Sites, and then click the Sites button. In the “Add this website to the zone” field, type the name of the website you want to include in that zone and click Add. Then click Close. 
You can add sites you trust to the Trusted Sites zone so that you can download content without prompting.
When you add a website to the Restricted Sites zone, Internet Explorer imposes the highest security level to the site and prompts you every time you visit.
To add sites to the Local Intranet zone, click the icon for Local Intranet, and then click the Sites button. In the Local Intranet dialog box that pops up, you can choose to automatically detect your intranet network; you can also click Advanced to add sites manually.
Demonstrate a Security Certificate
The HTTPS protocol is used so that your web browser can communicate with a web server in a secure way. Security is provided in two ways. First, the web server convinces your web browser that the site you are trying to access is legitimate and is not a fake site. Second, any password you send to the site, as well as any secure information, such as your credit card number, is encrypted so that anyone eavesdropping on your communication will not be able to decipher the content being passed between your computer and the server. Both of these mechanisms are handled by a security certificate. Secure sites will create a certificate that includes their own personal information (name, location) and an encryption key so that your browser can encrypt data. Most secure sites will have their certificate signed by a certificate authority to indicate its authenticity. Without this signature, you may not want to trust the site, even though you can communicate in a secure fashion.
Your web browser stores certificates for you and replaces certificates once they expire. To view a certificate of a website, click the padlock icon in the address bar. From the pop-up window, select View Certificates. You can find such details as the issuer (certificate authority), validity date, and encryption key. You can view all stored certificates in Internet Explorer by selecting Internet Options from the Tools menu > Content tab. From there, click Certificates, and you will see a list of all stored certificates.
When you reach a new site whose certificate is not signed or not available, you are given a message by your browser that there is a problem with the website’s security certificate, and you can either close the web page (avoid the site) or continue to the site (the browser will say it is not recommended). There are some sites that use “self-signed” certificates. This is usually the case only within an intranet. Since you have already logged in to the intranet and are visiting an internal site, you can trust the page without requiring a potentially expensive, officially signed certificate.
Demonstrate the Information Bar
The Information Bar appears whenever the browser needs to communicate about downloads, blocked pop-up windows, potential security risks, and other actions. This information helps prevent the installation of files that might be harmful to your computer.
The Information Bar displays only when it has something to tell you, such as when it blocks:
Microsoft ActiveX installations
Pop-ups
Downloads
Active content
For more information about the notification, click the Information Bar when it appears. 
Configure a Browser Home Page
To set Internet Explorer to load your favorite Internet site when you first open it:
1. Navigate to the web page you want to use as your home page.
1. Click Tools > Internet Options.
The Use Current button sets the page that is in the browser window at the time as the default home page.
The Use Default button sets the home page to a site chosen by Microsoft.
The Use New Tab button sets your home page to about:tabs. The advantage of this setting is that Internet Explorer will open quickly, because it doesn’t try to connect to the Internet.
Demonstrate Add-ons That Enhance Browsing
Web browser add-ons such as extra toolbars, animated mouse pointers, and media viewers provide added functionality to Internet Explorer.
Add-ons can enhance your browsing experience, but they can also:
Impact the reliability of Internet Explorer
Compromise security, because they might contain malicious programs
Clutter the browser screen, decreasing usable website space
Many add-ons can be downloaded from the Internet, with or without your permission.
Some add-ons gather personal information. Read the privacy statements from the website that provides the add-on before you download it to your computer.
Teacher Resource 15.4
Answer Key: 
Connecting to a Network Anticipation Guide
	The following are both examples of computer networks:
· Two computers connected to share files and printers
· The Internet

	My guess:
	I agree               I disagree

	My reason:
	

	I learned:
	A computer network is a group of two or more computers linked together to share files, printers, and resources. A network can be as simple as two interconnected PCs sharing files, a printer, or a modem or as complex as the Internet, which is made up of millions of interconnected networks sharing resources worldwide. 

	Communication protocols, such as HTTP and TCP/IP, are sets of rules for transferring data across the Internet.

	My guess:
	I agree               I disagree

	My reason:
	

	I learned:
	HTTP manages the transmission of hypertext documents. IP handles the actual delivery of the data, and TCP keeps track of the individual data packets that a message is divided into for efficient routing.

	Domain names like www.google.com have to be translated into IP addresses before network equipment can read them.

	My guess:
	I agree                I disagree

	My reason:
	

	I learned:
	Because domain names are words, such as www.example.com, they’re usually easy to remember. However, networking equipment uses a unique address called an IP address. Every time you use a domain name, a DNS server translates that name into the corresponding IP address.




	“Medium high” is usually a good security level for a browser.

	My guess:
	I agree                I disagree

	My reason:
	

	I learned:
	Medium-high security is appropriate for most websites. At this level, the user is prompted before potentially unsafe content is downloaded, and unsigned ActiveX controls will not be downloaded.


Teacher Resource 15.5
Quiz: Network Connections
Student Name:______________________________________________________________
Date:_______________________________________________________________________
Directions: Describe the important hardware and software connections that allow a web browser in this classroom to get information from a web server on the other side of the world. Write your answer as if you were describing these connections to someone who doesn’t know anything about how web connections work.
Your description should include information about the following points:
What equipment do you need to connect to a network? 
How do you set up the hardware to configure a wired connection? A wireless connection?
How do you set up the Internet connection, and what happens when you connect to the Internet? What does your computer connect to? What protocols does your computer use to establish the connection?



Teacher Resource 15.6
Answer Key: Network Connections Quiz
Descriptions should include the following information.
What equipment do you need to connect to a network? 
You need at least two computers, a network interface card, and network cables or a wireless router to connect to a network. 
How do you set up the hardware to configure a wired connection? A wireless connection?
To set up the hardware, either make sure your computer has an integrated network adapter or add a NIC in an expansion slot in the computer. The network adapter is either for a wired or a wireless connection; you need to know which type you have. Then configure either a wireless or a wired network connection using the Network and Sharing Center in Windows 7, 8, or 10. 
How do you set up the Internet connection, and what happens when you connect to the Internet? What does your computer connect to? What protocols does your computer use to establish the connection?
To connect to the Internet, you need a connection to an Internet service provider (ISP) such as a DSL or cable company. When you tell your computer to connect to the Internet, it sends a command using protocols such as TCP/IP and HTTP. Your computer, known as the client, establishes a connection to a port on the host computer, a server. The server responds to this request by sending data packets back to the client.


Teacher Resource 15.7
Key Vocabulary: Connecting to a Network
	Term
	Definition

	backbone
	The connections between the main components of a network. On the Internet, the backbone connects the most important routers and computers together. Other networks then connect to one or more backbone sites. Usually, the backbone is made up of the highest bandwidth components.

	browser
	A software application used to request and display web pages. A graphical browser can display graphics as well as text and can present multimedia information, including sound and video. The two most popular browsers are Google Chrome and Mozilla Firefox.

	client
	An individual computer on a network that makes requests of a server for various services such as file access, printer access, and running applications stored on the server. Clients depend on the server to store files and/or manage devices and resources for them.

	client/server network
	A network in which the server holds data and software that are shared by all client workstations on the network.

	DHCP (Dynamic Host Configuration Protocol)
	An Internet protocol to assign dynamic IP addresses to client computers upon request.

	DNS (domain name system)
	An Internet service that translates IP aliases into IP addresses. Every time you use an IP alias, a DNS server translates that name into the corresponding IP address.

	domain name
	An organization’s network name. Every domain name must be unique. Typically the domain name consists of two parts: the organization’s name and the Internet domain on which the site is located. For example, the domain google is located on the .com Internet domain, giving the domain name google.com. Another example is the National Academy Foundation domain name, naf.org. See also IP alias.

	firewall
	A piece of software (or sometimes a dedicated computer) used to protect your computer from being infiltrated across a network by a hacker. The firewall uses rules to determine what types of messages or connections are permitted and what types are rejected. If a message does not meet security standards, it is blocked. 

	HTTP  (Hypertext Transfer Protocol)
	Protocol that allows access to hyperlinked documents (web pages) from a web browser or a web server.

	hypertext
	A method of organizing information that allows a user to access related information by clicking on cross-references called hyperlinks.

	intranet
	A private computer network that runs on Internet protocols to share private information securely. It is accessible only by the company’s employees, corporate members, or others with authorization. The main purpose of an intranet is to share business information and computing resources among employees.

	IP (Internet Protocol)
	The layer of the TCP/IP protocol suite that handles the addressing of each packet to be transmitted.

	IP address
	The numeric designation assigned to any Internet resource. Internet servers usually have static IP addresses, while most clients have dynamic addresses.

	IP alias
	To communicate over the Internet, routers use IP addresses. However, these are hard for people to remember, so we use word-based IP aliases. The domain name service (DNS) translates IP aliases to IP addresses. Most IP aliases consist of a machine name followed by the machine’s domain name. 

	ISP (Internet service provider)
	A company that provides access to the Internet.

	local area network (LAN)
	A group of networked computers located within one building or adjacent buildings.

	MAC (Media Access Control) address
	A number that uniquely identifies the NIC or embedded network adapter in each node on a network. Each different type of network medium requires a different MAC layer.

	MIME (Multipurpose Internet Mail Exchange)
	A protocol that permits SMTP to transmit and receive binary files, not just text-only files. This allows us to attach image files and other forms of binary files to emails.

	network
	A group of two or more computers linked together to share files, printers, and resources. A network can be as simple as two interconnected PCs sharing one printer or modem, or as complex as the Internet, which is made up of millions of interconnected networks sharing resources worldwide.

	network interface card (NIC)
	An expansion board installed in a computer to allow it to be connected to a network. Also called a network adapter.

	node
	Any device on a network, such as a computer or a printer. Each node has a unique network address, called a Media Access Control (MAC) address.

	octet
	A group of eight bits, often referred to as a byte.

	packet
	A logical group of data consisting of the data to be transmitted, data to correct errors that occur along the data transmission path, and electronic code to route the packet to its destination.

	peer-to-peer network
	A network that has no server. In a peer-to-peer network, workstations connect directly to each other or connect to a hub or a switch to share data, devices, and resources. Peer-to-peer networks are typically found in home and small-office environments.

	protocol
	A set of rules that define the common language that computers use to communicate.

	residential gateway
	A hardware device that connects a home or small-office network to the Internet. It is also referred to as an Internet gateway device, a router, a base station, or an access point.

	SMTP (Simple Mail 
Transfer Protocol)
	An email protocol that determines which paths outbound messages take as they travel between servers, from a mail client to a mail server.

	socket
	A package of subroutines that provide access to TCP/IP on most systems.

	URL (uniform resource locater)
	An address for a web page. A URL address consists of a transfer protocol (usually http, but others include https and ftp), an IP alias (machine name and domain name), and a file name (including the file’s directory path).
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